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Welcome to Quick Scene!

This manual introduces you to Quick Scene,™ a drawing program for creating quick crash scene diagrams that are
ideal for state reports. It explains how to get help with the program, program basic concepts, and includes a basic
tutorial designed to get you drawing quickly.

How to Contact Us

Feel free to contact The CAD Zone with any questions:
The CAD Zone web site at: http://www.cadzone.com

Email Support: info@cadzone.com
Phone Support: (503) 641-0334 Fax: (503) 641-9077
Available Monday — Friday, 8:00 a.m. — 5:00 p.m. PST

System Requirements

To use Quick Scene you must have a computer with a Pentium IV or better central processor, running Microsoft
Windows XP, or a newer version of Windows. You must have at least 1 GB of RAM and 10 GB of free hard disk
space. The minimum screen resolution is 1024 x 768 pixels.

Copyright Laws Apply!

All CAD Zone software is protected by international copyright laws. You probably know you can’t legally make a
copy of someone’s book (if it is protected by a copyright) and give it to everyone in your department or company.
The same protection applies to software. When you purchase a copy of Quick Scene, you are actually purchasing
a license to use the program on ONE computer.

Each purchased copy of the software may be installed only on a single computer.

This means you can obtain one Access Key, which allows you to license the software on one computer for each
copy of the software you purchase. The CAD Zone’s complete license Agreement is printed on the envelope that
contains your program CD.

Install First - Then License Your Software

Separate Installation instructions are included in this software package. Follow those instructions to install your
program. You can only license your program AFTER IT IS INSTALLED onto your computer.

When you first install the program, it will be in Evaluation Mode. This means you can open the program 10 times
and have access to all of the program features. After those 10 times you can still open the program and try it out,
but you will not be able to save your diagrams until you complete the licensing of your new software. To license

your program for unlimited use, you must obtain an Access Key from The CAD Zone and enter it into the program.

The Access Key is unique to each computer - Call, email, or go online to receive your Access Key.

Before you can obtain an Access Key, you must purchase the program. The CAD Zone must have received a
Purchase Order from your government agency or have successfully charged your credit card.
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Find Your Computer ID

Each time you open the program, a Registration dialog box is displayed that prompts you to enter an Access key.
You can also bring up this dialog box at any time with these steps:

1. Open the program and select the Help pull-down menu.

2. Select License

Once the Registration dialog box is displayed, you will see the Computer ID for your computer. You must provide
this Computer ID to The CAD Zone so we can generate your unique Access Key. This Access Key will ONLY work on
the computer with the matching Computer ID. Once you enter your Access Key, your program will be fully
licensed and you have unlimited access to all the features.

To License Your Software Online
When you purchase your software you will receive an email notice with information on how to log onto the CAD
Zone website and obtain your access key, including a user name and a temporary password.
1. Asinstructed in the email, go to: http://www.cadzone.com/license and log in to your customer account.
2. Once you log in, you will be sent to the “Get Keys” webpage. Choose the product you wish to license and
enter the particular computer’s ID from the License dialog box.

Follow the instructions on the site to obtain your access key and enter it into the registration dialog box in the
program (described above).

To License Your Software Via Email
1. Open the program, select the Help pull-down menu, and then select License to bring up the Registration
dialog box, as described above.
Click the button “Get Access Key Via Email.”
3. Enter your customer information in the form that is displayed.
Click “Submit Email request for Access Key.” Your Access Key will be emailed to you, normally on the next
business day.

To License Your Software by Phone, Monday - Friday, 8:00 am to 5:00 pm, Pacific Time
1. Open the program, select the Help pull-down menu, and then select License to bring up the
Registration dialog box, as described above.
2. Call The CAD Zone at 800-641-9077 and give us your computer ID.
3. We'll generate your Access key and read it back to you over the phone so you can enter it
into the Registration dialog box.

Training Materials

Most Quick Scene users teach themselves how to draw by working through the available tutorials and training
movies. Quick Scene includes many resources that can help you learn to use the program, including the Learning
Center, the electronic help, movies, and tutorials.
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The Learning Center

The Learning Center is the first place to go for help with the program. There are a variety of training materials
here, including tutorials for those just getting started and tips and tricks for using the most complex features. The
Learning Center provides you with shortcuts to “How Do I?” topics, tutorials, step-by-step movies, electronic help,
and helpful web links.

Electronic Help

The electronic help (accessed from the Help pull-down menu), contains step-by-step instructions for commands
used in the program and instructional tutorials.

The Learning Center Movies

A number of instructional movies are included on the program DVD that provide step-by-step instructions for
many of the program commands. If you do not have access to the program DVD, the training movies can also be
viewed from the training section of The CAD Zone’s website, described below.

CAD Zone Training Web Site

The CAD Zone’s training website contains tutorials, user’s manuals, training movies, and other documentation. To
enter The CAD Zone's training web site:

Go to: www.cadzone.com and select the Training button

Or go directly to http://training.cadzone.com

Free Technical Support

The CAD Zone offers free telephone and email technical support. You can receive Email support by submitting
your questions to: info@cadzone.com. Telephone support is available by calling:

(503) 641-0334, Monday-Friday - 8 a.m. to 5:00 p.m. Pacific Time
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Program Basics

Before you start drawing, it’s a good idea to understand some things about how Quick Scene works, such as
compatibility, vector objects, drawing scale and satellite images.

Compatibility
The Quick Scene program will allow you to save to .BMP, .\WMF, .PDF, and .JPEG formats for easy placement into
text documents.

Vector Drawing Vs. Bitmap

Quick Scene is a “vector-based” drawing program, meaning you construct your diagram by creating objects such
as lines, circles, rectangles, text, colored fills, and so on. This method is best for drawing floor plans and site plans
because you can draw to actual measurements and maintain accuracy.

Since everything is constructed of objects, it’s very easy to edit your diagrams. For example, if you want to move a
line or symbol, you simply click on it and move it. You can also import Satellite Images from Microsoft’s Bing™
Maps and draw on top of the image for a fast way to create a pre-fire plan diagram.

Always Draw At 1 to 1 Scale

You never have to calculate a drawing scale when you draw. In Quick Scene you draw everything to the actual
measurements that you took at the site. In other words, you use a 1 to 1 scale. We expect to scale our drawings to
fit on a piece of paper, but the computer doesn’t have that restriction! Think of it like drawing on a sheet of paper
that is infinitely large. If you want to draw a building that is 200’ x 150, you tell the program to create a rectangle
with those exact measurements.

Once an object is drawn, its size never changes (unless you choose to scale it) so accuracy is always maintained.

You can zoom in on an area of your drawing to make an object look larger on the computer screen, but that just
changes the display, not the actual size of the objects. It’s like using a camera with a zoom lens. You only have to
set a drawing scale when you want to print your diagram.

The Program Screen

Throughout this manual, we will refer to various portions of the program screen. It’s very important that you
know where to find the Speedbar, the Left-hand toolbox, the Message Bar, and so on. Important sections of the
program screen are identified below.

Tip: Whenever you’re not sure what to do next, look at the Message Bar at the bottom of the program screen!
The simple prompts given on the Message Bar will help you learn to draw easier and faster.
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Keyboard Shortcuts

There are three ways to select nearly every command (feature) in the program - select from the Pull-down menus,
click an icon on the Left-hand toolbox, or type in a two-letter shortcut on your keyboard. Examples of two-letter
shortcuts include ZW for Zoom Window or C2 for 2-point Circle. The two-letter shortcuts are listed in the
electronic help, and they are shown on the pull-down menus, to the right of each command name. Using some of
the more common shortcuts can really reduce your drawing time.

Tip: There are a couple other keys on the keyboard that you will find to be very useful as you draw — the Esc key
and the Space Bar.

Esc Key — The “Escape” key is used to take a step backwards, backing out of a command. For example, if you are
placing points to draw a curve, pressing Esc will undo the last point, without canceling the entire command, so
you can place if differently.

Space Bar — Pressing the Space Bar on your keyboard will repeat the previous command. This can be a great
shortcut when you need to draw the same object or place the same symbol in multiple places.
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Use Aerial Photographs From Bing™ or Google™ Maps If'”ﬂs":" - Satellite Photos

| Scale 4,8
Import Satellite Photos [EM] .

A fast way to create a pre-incident site plan is to start with an aerial or
satellite photograph and draw on top of it. Quick Scene has Microsoft’s
Bing™ Maps and Google™ Maps integrated into it so you can easily find a
satellite image of any area. If you bring in a satellite Image from either

mapping system, it will automatically have a 1:1 scale. You can use the Quick Scene dimension tool to measure

the side of a building and the measurement will be accurate. If you draw on top of the image to trace a building or
other object, you will automatically be o ——— &
drawing at a 1:1 scale. R

To search for a Bing or Google image, click
the “Import Satellite Photos” on the left-
hand tool toolbox.

A new window is displayed with a text box
in the lower-left corner. Type an address or
the name of a location, such as a hospital or
school name in this text box. Within
seconds the satellite image is displayed.
Use the slider bar on the left side to zoom
in and out to get exactly the image you
want. Click the Place button and then click
in the diagram where you want to place the
image.

R L T ———————

Once the image is placed, you can use any @ s s oue v i oot oot e o 1]
of the drawing and editing tools in the :
program to draw on top of the image and
turn it into a pre-fire plan diagram. You
can use bold lines to show streets, place
text, and dimensions. Quick Scene also
includes thousands of pre-drawn symbols
that you can drop into place to show
vehicles, signs, utility poles, and more. This
is an extremely fast way to create a
detailed crash scene diagram!

Tip: Once the image is placed go into
Image Edit and Fade the image to make it
lighter so all of the other objects such as
symbols, text, outline and more will be
easier to read.
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Drawing Tools Draw | View Snaps Text - Dimension

Everything in your diagram will be constructed of basic objects like lines, arcs, # single LS
curves, circles, text, and so on. Lucky for you, you do not have to actually draw Ay continuous Lc
every individual object in your diagrams because most objects you will want to 95 Double LD
show are part of an aerial photograph or are provided as pre-drawn symbols. |[\j Curve cv

Even with so many symbols provided for you, it is still important that you learn to
use the basic drawing commands. You may want to add rectangles to outline
buildings and parking lots, place arrows (leaders) to call attention to details, or |
draw lines and curves to show streets.
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The left-hand toolbox includes a variety of commands for drawing basic objects
all grouped together under the Draw section heading. You can also select any of
the Draw commands from the Draw pull-down menu. There are multiple
commands for drawing some objects, like arcs, because they can be drawn in
different ways depending on what kind of measurements you have.

Descriptions of how to use some of the basic drawing commands will be given in ,
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Tools section of the left-hand toolbox.
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The top of the Symbol Manager toolbox shows which symbol group is Ml B - fo
currently displayed. In the figure here, it’s the “Vehicles A” group. If you click .31 = @ 4
the “More” button beside the word Quick Scene, you can select from the Deviabe  DevlaSde Deleie Bt
other symbol groups including, Crime, and My Symbols, which are symbols = 1] = ==
that you create. Codlez DTS Cafle:DTS Codla:¥R Codlle: ¥R
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Many symbol groups have multiple sub-groups that you select by clicking the
tabs above the symbol preview window. For example, in the Vehicles A
group, you can then select from the sub-groups: Cars, SUVs, Vans, and so on, — T
as shown here. When you click on a symbol to select it, a larger preview of
that symbol is shown at the bottom of the Symbol Manager.

e r?r::]t _ :*\]

Cadillac CTS Tope

Aege T Q
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Here is how to add a “Quick Car” symbol to a diagram: m

4 Quick Pick  ®=Vehicles A  #=Vehicles B

1. Open Symbol Manager and select Quick Pick symbol 8 Traficctl O Signs # Landscape
category. (This is in the Crash group, if Crash is not the «* Bodies = Weapons [ Landmark
current symbol group, click “More” and select it.) N North +

2. Click on the desired symbol in the preview window to select @ 1 2 3 -
it, the Quick Car symbol, in this case. 00_Impact m 02 03

3. Move the mouse pointer into the diagram and you will see a
preview of the symbol, attached to the pointer. 4

4. If you want the symbol to be exactly Window Help [F1] 04
horizontal or vertical, you can turn ON
the Angle Draw O° feature, located on ! S ft
the upper-toolbar. This makes it easy c
to place symbols so they are exactly
horizontal or vertical.

m

EE] <) oo T
08_Semi 08_Semi 03 _Semi 03 _Semi
Tractar Tractar Dotz Trailer Trailer Drats

Select the symbol and move Click to place the symbol's

the mouse pointerinto the first anchorpoint. Move Click int
drawing window. A ghost the mouse to rotate the finilsch ;?azli?'lgoit
image is displayed. symbol about that point )
) 1 =

|
S
—7] T e

All symbols are drawn at a specific size. For example, the Cadillac CTS is drawn to be the actual length of that
vehicle. If you are placing a vehicle symbol on a very large satellite image it may appear small. For some symbols,
you may want to change their size. You can do this with the Dynamic Scale feature on the Symbol Manager

1. Click the Dynamic Scale at Placement icon on the bottom of the
Symbol Manager toolbox. Ak % "ﬁl![ Dynamic Scale at Placement h

2. Click once in the diagram to place the symbol’s anchor point.

3. Move your mouse to the right and you will see an outline of the
symbol that gets larger or smaller as you move the mouse away from the anchor point. If you do not set
Dynamic Scale to on, you will not be able to change the symbol’s size.

4. Click again to finish placing the symbol when it has the desired size.

welect Objects : Selection Tool
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Textures and Hatch Patterns

It is easy to fill an area of your diagram with a pattern or a solid color. You can select from more than 100
textures and hatches, including grass, water, sand, concrete and so on. The Texture-Hatch toolbox is one of the
EZ Tools on the left-hand toolbox.

There are four command icons at the top of the Texture-Hatch toolbox that are different methods for placing
textures and hatches. You can fill inside existing objects, like rectangles, circles, polygons, by selecting them and
using the Hatch Selected command. You can click inside a completely closed area and fill it with the Seed Hatch.
You can fill an area of the screen with the Boundary Hatch command by clicking or snapping to boundary points.
Hatch Selected, Boundary Hatch, Seed Hatch, and Window Hatch all work the same way, regardless of whether
you have chosen to place a Texture, a Hatch or a Solid Fill.

EZ Tools

Here is how you can fill a swimming pool with a water
texture:

1. Click on the Textures icon in the EZ Tools section
of the left-hand toolbox.
2. By default, the list of Textures is automatically

displayed. Click on the “Hatch” tab to display the 1

list of “cross hatches,” or to fill an area with a ’

solid color. Siding_Log p
3. Scroll through the list of textures until you see Water_3 and click on it. St 4

Siding_Stucco_2
4. Make sure that “Auto Snap” is turned on, which is shown when the magnet 5o,

Show_2

icon at the top of the screen has a green o ctone
background. If it does not have a green background, click the magnet icon T, A
to turn Auto Snap ON. wal B Block =
a2
Tip: With Auto Snap turned on, the mouse pointer is turned in to a circular target. If waterd -
you position this target so an object or the endpoint of a line is inside it and click seskf0 S

your mouse, you will snap exactly to that object.

chh ? ¢App{y ﬁBEle

EY: ©O W

5. Click on the “Boundary Hatch” icon at the
top of the Texture toolbox.

6. Position your mouse pointer so one corner of the pool is
inside the Auto Snap target and click to snap exactly to that
point.

Window Help [F1]
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Wifith Auto Snap turned On,

click on the first corner
of the pool to snap to it.

Pool Diving

Snap to the next comer,
making surethe corner is inside
the target before you click.

Pool

Continue snapping to each
consecutive corner of the pool,
finishing with the original point.

7. Move clockwise to the next corner of the pool and snap to it.

8. Continue moving around
the boundary of the pool,
snapping to each corner.
Finish by snapping on the
initial corner point.

9. Press the Enter key on your
keyboard to complete the
boundary and place the
texture.

Tip: If a texture or hatch pattern
appears too small or too large, you
can change its scale. Click on an
existing Hatch or Texture in the
diagram, right click on it and select
Edit. Enter a larger scale to make
the pattern display larger or a
smaller scale to make it smaller.

Chlorine Offices

Tanks

b

C Lockers

L/ 1/

NN

o

Pool
2

00
~
Completed water
texture

;

Woading x

Hatch Selected Bring to
command Front command Send to Back command
- Select “like"
Bouncary i / surfaces.
Hatch :
There are other methods you can use to place command = VIR © Eﬁ’,
Al O
textures and hatch patterns, so you can choose the P & Select whether you
X i @ Hatch__ want to place a
one that works best for your diagram. Besides the Texture or a Hatch
. Seed Hatch attern.
Boundary Hatch command, there is Seed Hatch, command P
. . L~ Preview of the
Window Hatch, Hatch Selected, and Select Like selocted Texture
Surfaces. Window or Hatch.
Hatch
command
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Selecting Objects for Editing

As you draw and place symbols you will want to make changes
to your diagram. Before you can perform an editing command,
like Move or Copy, you must select the objects in your diagram
that you want to change. It’s easy to select a single object, you
simply left-mouse click on it. However, you will frequently
want to modify a number of objects at once, whether to
change their size, move all of them to a new location, or
change their properties.

Being familiar with the various selection methods makes
drawing and editing much faster because you can quickly
select just the objects you want to modify. You can see all the

selection commands by choosing “Select” from the Edit Pull-down menu.

(% File [Edit| Draw View Snaps Texts Dimension Utilities Window Help [F1]
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Tip: When objects are selected, they are displayed in pink and surrounded by blue, square handles.
Tip: To un-select objects, just click your mouse in a blank area of the drawing window.

Using The Mouse To Edit

When objects are selected, a red target symbol and a red square (rotation handle) are displayed near the center

of the selected objects. You can use your
mouse to manipulate these special

There are many ways to select objects!

To select a sing e object,
just click or i

handles as shortcut methods to move,
rotate, and re-size objects:

You can quickly select a group of objects & en
by enclosing them in a Selection '

The salected object is
dizplayed pink. B is enclosed
in blue selection handiss.

" = om

o

" (]

Press the E=ckey on the

keyboard or click ina blank

anea fo de-gemlat it

o

DCrasr 3 Sebselion Window

Ba select mulbipls objecks
at ance.

Window. Place your mouse pointer

above and to the left of the objects, hold
down the mouse button and drag your -
mouse down and to the right. When all wr

the objects you want to select are

Clisk ABCAVE mind de dba LEFT of

the abjects, drag your mouse
CKOWH and to the RIGHT.

p

2

Wiihan all thes eljocbe pou wand

o sabect are ENCLOEED in the

wirdow, et up o the bufion.

-:'g. "

Uee a Crossing Window
o ss=lact muliple ohjects
al oroe

completely enclosed in the window, let
up on the mouse button.

Similarly, you can select all objects that <
cross through a selection window by

Click BELOW and bo the RIGHT of
the abjecle, drag your mouse
UP and o the LEFT.

57

Vithen all the objecls you want ta
select are CROSEING ar enclosed in
the window, et up o the bution.

drawing the selection window in the
opposite direction - start below and to
the left and move your mouse upward,

down the Shift keyon the

to the right of the objects to select.

To S00 ko the sslaclion, HOLD

keyboard and click onan object.

T REMOVE chizcls from the selection,

HOLD down the CTRL key an the
keyboard and click an the object
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Tip: If you have a large diagram and you select a small object, you may see it turn pink but not be able to see the
selection and rotation handles. Simply use the Zoom Window command to zoom in around the object until the

handles are displayed.

To move the selected objects -Place your mouse pointer inside the blue selection handles and hold down the

mouse button to drag them to a new location. (If you want to snap objects to a precise point, use the Move

command by typing MV on your keyboard.)

To rotate the selected objects -Place your mouse pointer on the red, square rotation handle near the center of

all the selected objects and drag your mouse in a circular motion. (If you want to rotate objects an exact angle,

use the Rotate command so you can enter the precise angle.)

To scale, or resize, the selected objects - Place your mouse pointer on any of the blue, square selection

handles and hold down the mouse button to drag them to a smaller or larger size. If you want to resize objects
proportionally, not changing their ratio of width to height, place your mouse pointer on a selection handle that is

on one of the corners and drag it to the new size.

Editing Commands

Once an object or objects are selected, they can be modified with the various Edit
commands. Edit commands can be performed either by selecting one of the Edit
commands from the Edit pull-down menu, by selecting a command icon from the
left-hand toolbox, or for some commands, by using your mouse.

There are commands to Cut, Copy, Paste, Move, Break an opening, Trim or Extend
Fillet, and so on. For many editing operations, there is more than one way to perform
it, so you can choose the one that gives you exactly the results you want. For
example, if you want to make a copy of some objects you can use the standard Copy
to the Windows Clipboard or the Multiple Copy command which allows you to make
multiple copies of selected objects to an exact location.

Tip: Whenever performing an Edit command, be sure to look at the Message Bar at
the top of the screen. This is where you will get instructions on what to do next!

lan 1.0.0 - [Untitled-2012-06-18_141245.czd]

Draw View Snaps Text s Dimensior

9 Undo o0
™ Redo RE
& Cut Ctri+x
| 53 Copy Ctr+C
[ Paste Ctri+v
Select 4
o Edit QE
oo Copy MC
‘@ Move I MV
<o Break BR
1— Trim/Extend TR
—§ Fillet (Round Corners) FI
=1 Offset OF
x Delete (Erase) ER
i Image Edit
== Image Scale

Edit Properties

Many of the Edit commands require you to choose a reference point, or handle, and a new location for that
handle. For example, when you start the Move command, the Message Bar at the top of the screen will prompt
you to “Pick Reference Point.” You can click on any point, or snap to grab an exact point like the end of a line.
Think of this as the handle by which you will pick up the object. Next you are prompted to “Pick Offset Point.” This
point is the new location for the handle. If you wish to move the objects to some exact point, be sure to use Snap

commands to accurately grab each of the reference points!

Next, we’ll give specific instructions on how to perform two of the more detailed Edit commands, including

Trim/Extend and Break.
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Trim and Extend

Use the Trim/Extend command when you want to trim or extend an object so
it ends exactly at another object. You can use this command to trim or extend
lines, continuous lines, arcs, and curves. For example, when creating an
intersection you can trim or extend a line that represents one side of a street
so it ends exactly at another line.

In this example, we will trim the top horizontal line so it ends exactly at the vertical
line. To trim or extend an object to another object: — 1

1. Click on the Trim & Extend icon on the left-hand toolbox, or select the
Trim/Extend command from the Edit pull-down menu

2. Click first on the object to be trimmed, near, but not on the end that is being
trimmed.

3. Next, click on the object to which the first object will be trimmed, the vertical
line, in this example.

The first object will be trimmed or extended so it ends exactly at the second object that
you selected.

Break

Use the Break command when you want to break a gap, or hole, in an object.
For example, you may want to insert an opening in a wall for a door or
window.
1. Select the Break command from the left-hand toolbar or from the Edit F==HF==4FF /1 =13
pull-down menu.

2. Select the line or object that you want to break. You A i B
can click on it or use any of the selection methods.

3. Click or snap on the object where you want the break
to begin. This point need not be exactly on the object;

the break will start at the point closest to the point you ﬁP =
place. A
4. Move your mouse and a dynamic preview of the break
appears, changing as you move the mouse.
A B

Click or snap where you want the break to end. A hole is broken
in the object between the two points you selected.
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Changing Views

As your diagrams become larger and more complex you will frequently want to [View] Snaps Text - Dimension

change how the diagram is displayed on the screen. That’s where the View, or Zoom, '& Redraw kD
commands come in. You can show the entire diagram on the screen (using the Zoom Wy, Zoom Al [s s
All Command), but then it may be difficult to see the smaller details. You will learn to | & Z0om Window  ZW

\
K,

o+
zoom in to draw small details and zoom out to make more visible space for placing a "“ Zoom In “l
. . 0y \=y Zoom Out ZO
large item, like a building. d )
i/ Zoom Previous  ZP
) £ pan PA
Tip: You can think of the Zoom commands like using a zoom lens on a camera. Using
any of the View commands does not change the actual size of any objects in the @ Bring To Front  TF
diagram, it only changes how they are displayed on the screen. If an object was cosaiimisay
drawn to be 20’ long and you perform a Zoom Window around it, the object will Iot Blot Out
appear larger on the screen, but it will still be exactly 20’ long. Blot Prefs
@ nitevision NI

All of the View Commands can be selected from the View pull-down menu. The most commonly used View
Commands can also be selected from the Speedbar, the toolbar that runs across the top of the drawing window.
These include:

Redraw — Use this command to refresh the screen. If you do .
some editing and deleting and it looks as if objects have been g ‘S\ @."{‘ 0\}
partially erased, don’t panic, just do a Redraw! b“:b {(‘

Qg‘ 1,0 1/0 .1/0 1/0
Zoom All — Click this button to make the entire diagram fit

Zoom Window — This command lets you use your mouse to
draw a window around some details in your drawing. The
view of that window is then expanded to cover the screen.

Zu:uom All [Z.-\

Zoom In and Zoom Out - Use these commands to change the view of the diagram to be incrementally larger or
smaller with each click.

Blot Out and Blot Preferences

Blot Out is a feature that makes it easy to highlight text, symbols, arrows, and other objects by “blotting out” the
objects behind. Blot Out is especially helpful to highlight text drawn on top of an aerial image or a texture.

Yiew

.o[_]

Blot Prefs Ehk D
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To apply Blot Out to a selected object, click the Blot Out icon in the View section of the left-hand toolbox. You can
also position the mouse pointer on the selected object, click the right-mouse button, and then select Blot Out
from the menu that appears. Clicking the right-mouse button brings up a menu of commonly-used commands,
including Blot Out and Blot Preferences.

Select the text,
Text with no right_mouse click Text with

Blot Out and select Blot Out Blot Out

"
B wotou
ﬂ Bt -..rr,...h'

L

( Blot Prefs e |

The “Blot Preferences” command lets you change the settings used with Blot Out for

new objects to be drawn. You can select whether to automatically apply “Blot Out” I Use Backgraund Calor
to all future text, dimensions, symbols, and arrows. You can also select whether to St Blot Qut Calor.
always use the diagram background color for blots or select a specific blot color from Ea T
a pull-down list. AutoBlat
v Test

. . . . . v Dimensions
Tip: By default, “Blot Out” is automatically applied to text, dimensions, arrows, and v Arons
symbols. This means when you first start using Quick Scene, whenever you place one W Symbols
of these items, the image behind it will be blotted out. Select Blot Preferences and
uncheck any of these entities if you do not want to apply a blot to that entity. ok I Cancel

L5 &

Tip: Changing the Blot Preferences will only affect new objects you
draw. It does not change how a blot was applied to an entity already
placed in the diagram. To change the Blot preferences on an existing
entity, click on it to select it and then click your right-mouse button
to bring up a menu of commands. Select “Blot Out” to remove the
blot completely or select “Blot Prefs” to change the blot color.

Blot Out

Blot Prefs. "
L

Cut
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Creating a Quick Crash Scene

With Quick Scene, even new users can create a diagram in less than 10 minutes! In this tutorial we’ll show how to
use Quick Scene’s unique features like Templates and Easy Intersection to draw a crash scene faster than you
thought possible. The completed diagram is shown at the end of this tutorial.

When you first open Quick Scene the Let’s Get Started screen appears. From this screen you can Create a New
Diagram using several different tools, Open an Existing diagram, or go to the Learning Center.

" Small - 50' {15m)

The Learning Center contains links to help [ Lers et stonea |
topics, tutorials, and movies that explain how & 4~ Name Drawing
to use the various features in the program. F S e

NEW [Feet & Inches ~|/ 0. x| Example3 s
We will start this tutorial by creating a new ® rennn 2 :il;l:”ftlst:tri-:g;ool
diagram and drawing a specific intersection = £ Create 2 Building EASY INTERSECTION
with the Easy Intersection toolbox. This special (D uvroare - :;:)I::;Templates = " e
toolbox lets you quickly add details to your e . ' ¥
intersection like number of lanes, cross-walks, 3, Fick Approximate Site = - g L

turn lanes, bus turn outs, and so on. 9 M =507 Fi
" Large - 600° {183m)

© Custom Si [ 1 i e
ustom Size Create

0 0.00° L Border

Later in the tutorial, we will see how to select
common intersections from the many pre-

drawn templates included in Quick Scene.

1. Click the “New” button to start a new diagram.

2. Click in the “Name Drawing” text box and type in a name, like: Crash Sample

3. You can change the units for your diagram, if desired. This tutorial uses units of Feet & Inches.
4. For the “Starting Tool”, select “Build Intersection.”

5. For the “Approximate Site” size, select: Medium 300'.

6. Click the “OK” button to start the diagram with these settings.

Creating an Intersection

The Easy Intersection toolbox is now displayed. Easy Intersection allows you to quickly create an intersection by
choosing the location, angle, number of lanes, and other details of each road segment.

Tip: You can also select Easy Intersection from EZ Tools on the left-hand side of the
screen. The EZ Tools group contains many commands that help automate tasks like
drawing an intersection, placing a building outline, filling an area with a pattern or

texture, and placing symbols.

Quick Scene
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Eazy Intersection liﬁ-‘
ﬂ|Pmp-urﬁu ] 3=
Lare | aidth Line Type - ﬁ Stieet Rotation = 17 mnwmm?-il.? E:
2o - i * i is
i [T picka L
Set lane D th d basic
properties. rag the re || shape.
Features handle to
0% sy rotate the |
i
Click on a EE pEe EE
lane, to 3; s""“...:“’“"m..., - - L]
- 0 e [ [F)[E
selectit, then™ = M Click 1
add features || “fmmh =t vl lckto
like turn ﬁ::r - / wrn lanes
Janes and + + + + Click on a lane ¢ off oron.
crosswalks = to select it.
’ l:uung I Deubles E ; 'E
EOEEEEREDE ‘a OFF 3 °
BEEE 1 Ll Opions. | Place | Cowe |
Change the length.

Each road segment has a check box and a number of lanes with up/down arrows. You can adjust the number of
lanes in just that segment, or click in the box to “uncheck” it to turn that segment off completely. As you make

changes, you’ll see the intersection being built in the preview window.

You can also adjust the angle of any of the road segments.
Move your mouse pointer over the red rotation handle of a
segment and notice it changes to a round arrow icon. Press
and hold down the mouse button and drag that road

segment to adjust it’s angle.

Use the Options button, in the lower-right corner of the
toolbox, to set several options that affect all the road
segments in the intersection, such as the Lane Width and
the maximum length of the road segments. This dialog box
also lets you set the Fillet Radius used to round the corners

"8 S LB - [l Sl
i Bdn D Ve Eeupe

 coset |68 [ERITIER) v

2

| ol

S
2
i 2

ACIEE
Aflal]
| =]

S[:[[4

of the intersection and the line type to be used for Center B
Lanes [erou O |
’ o prote (5 5
FHEEREH
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To create the intersection, make these changes in the Easy Intersection toolbox:

© 00N O 01 W IN -

intersection on the drawing screen.

Save the Diagram

. Decrease the length of the road segments by moving the “Street Length” slider to the left.
. Click in the box by lane 3 (horizontal, to the right) to uncheck it and turn it off.

. Use the up-arrows to increase lanes 1 and 5 to have three lanes.
. Grab the red handle on lane 7 and drag it to a new angle.

. Click in lane 7 and add a bus turn out (under Features, on the left side of the toolbox).

. Click in the center lane of lane 5 and add a left turn bay (under Features, on the left side of the toolbox).
. Add crosswalks to lanes 1 and 5.
. When you are satisfied with the intersection, click on the Place button to place the completed

It's a good idea to save your diagram frequently, to ensure you never lose any work. Quick Scene automatically

creates a back up copy of your diagram while you work, so you can open it if you can’t

find a file or if you forget to save.

1. Click the Save icon on the top toolbar to save the diagram to the hard disk of

your computer.

Placing Symbols

A File Edit Dre

Save [DS] |4

Next, let’s add some symbols to show the position of the vehicles involved. Quick Scene includes hundreds of
predrawn symbols with a special Symbol Manager toolbox that helps you find

the symbols you need and place them at the desired size, rotation, and color. All

the symbols are arranged in categories, such as Vehicles Signs, Traffic Control,

Signs, Weapons, Landscape, and so on. In addition, many of the categories, such

as Vehicles, have subcategories to further organize them.

e
s | TIr

|0

1. Select the Symbol Manger icon from the left Toolbox. Symbol Manager [MGY]
1 |
2. Select the Quick Pick symbol category. m
. i . # Quick Pick == \Vehicles A &=\ehicles B
3. Click on the Quick Car symbol to select it.  Trafficctrd @ Signs % Landscape
7% Bodies 7 Weapons [ Landmark
& North +
4. Position your mouse pointer where you want the front of the first @ 1 5 3
vehicle and click. If you make a mistake, just press the Esc key on the 00_Impact o 02 03
keyboard and you can plac.;e the symbol again. A B, oo
5. Move your mouse and notice that you can rotate the symbol to any 0 [EETETIRT] 05 Quick Cor 07 Guick Car
Crots Parked L
angle. Click again when it has the desired angle. & -~ 1
. . - . . . = I U
6. Click again to finish placing the symbol when it has the desired oo (om0 Seni 095
rotatlon Tractar Tractor Dots Trailer Trailer Dotz
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Tip: The Symbol toolbox stays on the screen so you can quickly place all the symbols you need. When you are
finished placing symbols, click the “Back” button at the bottom of the Symbol Manager to return to the main

toolbox.

Select the symbol and move
the mouse pointer into the
drawing window. A ghost
image is displayed.

Click to place the symhbol’s
first anchor point. Move
the mouse to rotate the
symbol about that point

Click again to
finish placing it.

|

T

There are options at the bottom of the Symbol Manager that allow you to mirror a symbol, change its size and

change its color. Next, let’s place a bus symbol and change its color to blue.

7. Click on the 10_Bus symbol to select it.
8. Click the “Set Symbol Color” icon and select a color of blue for the
bus.

9. Place the bus in the diagram, using the method explained above.

If you don’t like the lines of the crosswalk running through the bus, you can
use the “Blot Out” feature to cover them up.

10. Put your mouse pointer inside the bus symbol and click the LEFT
mouse button to select the symbol. The bus turns pink and has
blue “handle points” to show it is selected.

11. Next, click your RIGHT mouse button to bring up a menu of
options you can apply to the selected symbol.

12. Click on “Blot Out” to turn it on for this symbol.

= iﬁ‘fi-‘fhli R

i Objectsl Set Symbol Color L|
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Click on the Click your RIGHT Select
symbol to mouse button to Blot Out
select it. bring up the to turnit on.
options menu.

—
D Blot Out [}
hd ﬁ Blot Prefs...
v
- & Cut o /

" ia Copy
Tip: If you want to place a symbol or other object so it is exactly horizontal or vertical, Window Help [F1]

click on the “Angle 0°” icon on the top-toolbar (just under the pull-down menus). This
feature restricts the mouse so it can only move horizontally or vertically. Click it again
to turn it off when you no longer want that restriction.

Next, we’ll place a stop sign, again from the Quick Pick folder.

13. Select the Stop Sign symbol from the Symbol Manger.

14. Since we changed the previous symbol’s color, this ‘ ‘
setting may still be applied. Click on the Symbol Color
option (on the bottom of the toolbox) and the color should
change back to the default color of red.

15. Click the Dynamic Scale button (on the bottom of the

Symbol Manager toolbox) to turn this option ON. - /
i Dynamic Scale at Placement =

11. Now click once in the diagram to anchor the symbol. As
you move your mouse you can make the symbol larger or //
smaller, as well as rotate it about the anchor point. When
you are satisfied with how the symbol looks, click again to
finish placing it.

Tip: If you don'’t like where an object has been placed, like the stop sign, simply click on it to select it, then hold
down the mouse button and drag the object to a new location.
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If you want to label the car and bus symbols, you could use the Text command, but an even faster way is to use
the numbers that are included as pre-drawn symbols.

Change the View and Number the Vehicles

First, let’s zoom in on the area around the vehicles so we can have better view to place the labels. Icons for the
view commands are located on the top-toolbar, just under the pull-down menus.

1. Select Zoom Window icon from the top-toolbar.

A

{

2. Click the mouse pointer above, and to the left of the vehicles, i
near Point A in the following figure. b » D D E

=
3. Move the mouse pointer down and to the right of the vehicles [ Zoom Window [ZW] |
and click again near Point B.

The display should now show an expanded view of the intersection,
showing everything that you enclosed in the window. You will A
frequently use the View commands, like Zoom Window, to make it
easier to place symbols and see the details of your diagrams. Use
the Zoom All command to display the entire diagram.

\x_i__

& -
.-'-""'j/ h
=" ll '-IF;{
—

\

Tip: Zoom commands are like using the zoom lens of a camera. The

size of objects in the diagram is not changed, only your perspective. Jﬁ"\//
I
Now we are ready to place number symbols: ;X ([eTAD ] B
4. Click the Dynamic Symbol Scale icon (on the bottom of the AN % A Dynamic Scale at Placement |

Symbol Manager) to turn it OFF.

5. Click on the “Angle 0°” command on the top-toolbar to turn that feature ON. When Angle 0° is turned
on, your mouse will be restricted to only move horizontally or vertically. This makes it easy to place text
that is exactly horizontal.

Window Help [F1]

v ft

Tip: You know Angle 0° is turned on when the icon has a green background. Click the icon
again to turn it off.

™,

Angle 0° [09]
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6. Select the 1 symbol from the Quick Pick folder and place it on
the car.
7. Select the 2 symbol and place it on the bus.

Take some time to explore the symbol categories available on the
Symbol Manager and place additional symbols in your diagram. You
may want to place some more signs, landscape symbols, and a North
Arrow. Experiment with colors and the Dynamic Symbol Scale feature
to make the symbols look exactly the way you want them.

\\

8. Click the Back button on the bottom of the Symbol Manager
to return to the main toolbar.

§

<

Tip: If your screen doesn’t look quite right or appears to have stray marks on it, just click
the Redraw button at the top of the screen to correct it. You will frequently want to use
Redraw to refresh the view when you move or rotate objects.

@

'e
E

This is a good time to save your diagram! Get in the habit of saving frequently. Redraw [RD]

9. Click the Save icon on the top toolbar to save the diagram to the hard disk of your computer.

Draw the Skid Marks

Quick Scene has tools for drawing lines, continuous lines, arcs, curves, circles, and rectangles. You will use these
tools to draw anything unique to your scene that can’t be shown with a symbol. You can also apply different
properties to any of these basic objects, such as color, line width, and line type. Line types can be solid, centerline,
or dashed, and they can be used to show more complex shapes like fences, guard rails, and railroad tracks.

In this tutorial, we will use the Line command to add skid marks to the diagram

with a specific skid linetype. We will start by selecting the line properties.
solid LY
1. From the Properties section of the left-hand toolbar, click on the Line |@E

Type button. It may say “Solid” on it, since that is the default line type.

Line Type = Solid

F 1

2. Click on the Skidmark 3 line type to select it.

3. Click the Back button to return to the main toolbar. s =

—eme T TP gl WY AR e A

Any new objects you draw will be drawn with this line type, until you T e e = =

select a different line type. R [ -
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4. Click the the “Angle 0°” command on the top-toolbar to turn that feature

5. Select the Single Line command from the Draw toolbox on the left.

A line is drawn by clicking any two points in the diagram. You can also
draw a line to an exact length by using the “Direction - Distance”
method. You click to place the first endpoint of the line, move your
mouse in the direction of the line and, instead of clicking to place the
second endpoint, type in a distance. We will use this method to draw

OFF.

the first skid mark for the bus.

5.

command to make a copy of the first Skid and place it in line

with the other wheels.

. Select Properties from the left-hand
toolbox and change the line type back to

Solid when you are finished drawing
skidmarks.

| [55] = [ ] HRPEN

Line Type = Solid

# 1

Here is how our drawing looks so far:

Quick Scene
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Click to
. . . place :

Click at the rear of the bus to place the first end point of the the first a!"f-
skid mark. endpoint. /

. Move the mouse parallel with the edge of the street to show /
the direction of the skid. Do not click! ’

. Type 28’ and press the Enter key. This draws the skid mark to ) / -
be exactly 28’ long.

. Repeat steps 5 through 7 to draw a second skid mark for the B
other wheels of the bus. Alternatively you could use the Copy z"l

Move your
mouse in
the desired

direction and
type inthe
distanc’e.

STOP
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Applying Other Line Types

You can apply a Line Type to any line, arc, curve, rectangle, or circle that has Click here/ A
already been placed in the diagram. For example, you can change line types to start
of the centerlines in the intersection or apply a fence or guard rail Line Type the line.

to an existing line. |

Let's draw a line beside the three-lane street and .
change it to a guard rail. % I ‘-1;
LIS
1. Select the Single Line command from the I Single Line [L5] - 2 — :_.r*".f}
Draw toolbox on the left 4 1. r
2. Click to the right of the upper endpoint of the three-lane street, point | —" a,'i/,‘

Ain the figure. _/

3. Hold down the Shift key on your keyboard. This temporarily restricts ) &
the mouse so it can only move exactly horizontal or vertical. (You / Hold down
could also use the Angle O command to do the same thing.) the Shift ke
4. Move the mouse downward and you can see a ghost image of the move the moLise
line stretching out from the original point you clicked. downward.
5. Click again and let up on the Shift key to finish the line. Click to finiqh
6. Once the line is complete, click on it to select it. The line changes to the lin e.\
pink to show it is selected. It will also have blue “handles” that you . B

can drag to change its length.

Tip: You can select an individual object by clicking on it. You can select multiple objects by placing a window
around them. If you drag the selection window from the upper left downward to the lower right, all the objects
that are completely enclosed in the window will be selected. If you drag the selection window from the lower right
upward to the upper left, all the objects that are enclosed or cross through the window will be selected.

The next step is to apply the desired line type to the selected line. You can select a line type from the Properties
section of the left-hand toolbar (as used above for the skid marks) or you can

use the “right-click menu.” £ Layers
io: Colors 4

7. With the line selected, click your right-mouse button. This brings up a e#) ine types I\

menu of options that can be applied to the line. |’ Widths
8. Select Line Types from the menu.
9. Put your mouse pointer on Guard Rails to see all the Dash Dot Styles ¥

possible Line types. Center Lines ’
10. Click on one of the Guard Rail line types to apply it to Guard Rails & cuardrail

the line. Dividers Guardrail

a4

Roadway '|Q Guardrail s

Skids L ﬁ W-Beam GLITSrd
a4

W-Beam Guard

Fences
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To display your entire drawing on the screen, type ZA
(for Zoom All).

You can also select the Zoom All command from the
top toolbar.

ajaje @

~Zzom Az

Here is how the drawing looks with the guard rail

Place Text Labels Text
Next we’ll use the Text feature to label the Text = Dimension Labels
streets and place a basic dimension. Yo Vs
Enter Text */ I__EJ/ @ qT/
1. Select the Text feature from the wilson Ave
Text-Dimension portion of the left-
hand toolbox. Ted [QL]
A new toolbox is displayed on the left where you enter the desired text
and choose all the settings that determine how the text looks.
2. Click once inside the “Enter Text” box and type in the desired Height: Calar:
text: Wilson Ave (do not press the Enter key). 5000 Af A E ~
3. Move your mouse pointer back into the drawing window and Fant:
notice an outline box that represents the size and rotation of the |mia| j
text.
4. Change the text height by clicking on the large “A” or small “A” B I 4, E?::Eﬁw Tf'ﬁag'gg
text buttons. Alternatively, you can type a value in the box for the === : —
text height. For this example, set the text height to 5'.
[ Bepeat [
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5. Try the other Text options, for example, change the text color to green and change the font, or make it
bold or italics.

6. Move the mouse pointer back onto the drawing screen and notice a box attached to the mouse pointer
that represents the text.

7. Position the mouse pointer above the two-lane street and click. This anchors the lower-left corner of the
text at that point.

8. Move your mouse and notice the text rotates around this anchor point.

9. Move your mouse to the right so the text box is parallel to the street edge and click again to finish
placing it.

Tip: If you notice that the text can only exactly horizontally or vertically, it means the Angle 0° mode is turned on.
Click on the Angle 0° button, on the top toolbar, to turn it off and try rotating the text box again.

angles other  tent move themouge | Movethemouseto  Align the text with
gres . ext, move . € m?use rotate the text about the road edge and
then horizontal into the drawing window " =\ = point click to place it
or vertical, and click to place the ' :
lower-left corner.
Window Help [F1] | 1 4=
| = I JFL JH
| = /2 T2 "2,
EB4 Angle0® (09) /1 &
—_—_—— .1-‘?;*-. o 1: wison A —" 1‘-";_.
Make sure T — - - _ L
. g
Angle Draw 0" . — "~
is tumed OFF, - : r
[ate o e o

The Text dialog box stays open so you can continue placing other labels. Repeat steps 2 through 9 to place
additional text in the diagram, such as the name of the other street and details about the vehicles. You can also
click on any of the “Pre-defined Labels” on the Text dialog box as a quick way to place that text, such as One Way,
and Stop Sign. Use the Add Label button to add your own text labels to the list of Pre-defined Labels.

Il.l.l.".l II-\_".l

10. To add the “Metro Bus 128" label, click the “Show Arrow” option and add an =
arrow with the label. The first point you click places the tip of the arrow.
zat v Show Arrow

11. Click the “Back” button on the Text dialog box when you want to stop placing -defined 'tabels
text.
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Hwy 12

Your diagram should now look like the one in this
figure, including the new text we just added.

Tip: If you delete a text label or a dimension, it may
fﬁ?’l look like a large area of the diagram has been
i;f"ét\ erased. Just use Redraw to refresh the diagram.

rﬂ=';'f w Help[Fl]
7

~ | cak RYENEY

Redraw [RDY |

AT E I NN AN IR A A NN A EE A R A A A N A A EE AN AN

Place Dimensions

Quick Scene has tools for placing linear, angular, and radial dimensions in your diagrams. You access all of the
dimension tools and settings by selecting the Dimension icon on the left-hand toolbox.
We will add a dimension to show the length of the bus skid marks.

Text » Dirmension

1. Click the Dimension icon on the left-hand toolbox to bring up the Dimensions
dialog box. This dialog box has all the settings you can apply to make
dimensions look the way you want them.

2. Change the text height to 4’, the color to red, and the direction to “Aligned.”

. Use Zoom Window to zoom in closer to the bus.

4. Click on the Auto Snap icon on the top toolbar (the magnet) to turn this
feature ON. When Auto Snap is on, your mouse will snap exactly to an
endpoint of a nearby line.

5. Click on the top endpoint of the line we drew to show the skid mark. Since
Auto Snap is turned ON, the endpoint is selected exactly.

6. Move the mouse downward and click on the other end of the skid mark.

. Move your mouse to the left and you'll see the dimension take shape, with a box that outlines the text.

8. When you are satisfied with the position of the text, click a final time to place the dimension.

w

\'
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When you place a dimension, Quick Scene calculates the exact measurement between the two points. Since we
used the Direction-Distance method to draw the line for the skid mark, the dimension measures it as 28’. It’s also
possible to override the value calculated for a dimension. This may be
helpful if you draw a sketch without using any particular measurements.
You can edit a dimension to change the dimension text, as follows

1. Click on the dimension to select it.

2. Click your RIGHT mouse button to bring up a menu of options 28' 0"
and choose Edit. This displays the Dimension dialog box. i
3. Click in the “Set Dimension Text” box and type in the value you |ed£§ Edit
Move Té’ket
want. Slide Text

4. Click “Apply” to complete the change.

Dimension Line Move

There are other options on the “right-click” menu that you can use to change how your dimensions look in the
diagram. For example, if you place a dimension and the text appears too crowded, you can move it to a new
position. Click on the dimension to select it and click your right mouse button to bring up the options. Use the
Move Text feature to move the text away from the arrows, or select Slide Text to slide it along the dimension line.

5. Click the “Back” button to close the Dimension dialog box and return to the main toolbox.
6. Select Zoom All from the top toolbar, or type ZA, to display your entire diagram on the screen.

Printing Your Diagram

To send your diagram to a printer, use the Print command found on the File menu or select the Print icon from
the top toolbar. With this command, you can set many options that control how the diagram will be printed.

3 File Edit Draw View Snaps Text« Dimension U

1. Select the Print command from the top toolbar, or by choosing it from nm @ “"‘i'
. [:] BLAF] k=4 o™} O
the File pU“-dOWn mendu. Properties Print Drawing [PR]

Quick Scene
The CAD Zone, Inc. — 4790 SW Watson Ave, Beaverton, OR 97005
800-641-9077 www.cadzone.com Page 30




The default Print settings use a portrait paper orientation and automatically scale the diagram to fit on the paper.
You can always enter a specific print scale if you want to print the diagram at an exact size so you can take

measurements off the paper print of the diagram.
Prict L -

Prrwss / Page e
SAMECTECESHP Laneet 3000 FTL

1. Use a Portrait paper orientation so this diagram QITEI0E .

P Sl

fits better on the paper. This setting will be - "lwt*::""
different depending on the shape of each ﬁﬁ.,
diagram. 2
2. If desired, adjust the print scale by entering a _E'T»L.m :::j
value on the Print toolbox. In this example, we - :ﬁ":"’_‘ a2 e
checked the “Scale” option, entered a value of ﬁ:::?T:
17 = 25’, then clicked “Update” to update the o | P
preview window. _ Eﬁ'i:jf",: %
3. When the diagram appears the way you want it L N P

in the preview window, click on the Print button.

Preview of how the diagram will

Select Portraitor Landscape orientation.
look on the paper.
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exactscale. Page Matkz [Camer =] " Bold
[ Priet Lo File
D .
W o I
Click here ___— oise after Pt
when you are [ Restone Last prinker Selup..
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Normally, when you draw in Quick Scene, you draw everything to actual measurements. There is no need to
“scale” anything to get it to fit in Quick Scene. When you draw an intersection with Easy Intersection and place
vehicle symbols, they will measure to the size those objects have in the real world. It is only when you want to
print a diagram does it have to be scaled down to fit onto a sheet of paper.
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By default, the Print dialog box is set up to print the diagram with the “Fit to Paper” option. This means the
program calculates the best scale to use based on the size of paper you have selected. In this figure, we chose the
“Scale” option and entered an exact scale of 1” = 25’. By entering an exact scale, it makes it easier to take

measurements from the printed diagram.

Using a Specific Scale

If you want to use a specific scale that is a smaller value than the one calculated for “Fit to Paper,” the diagram

will no longer fit on one page. In this case, the drawing is “tiled” by splitting it across multiple sheets. Each sheet
of paper in the preview window is shown by dashed, red lines. You can use your mouse in the preview window to
drag the drawing so it fits differently on the pages.

Let’s see how Print Tiling works with our
tutorial drawing.

1. Open the Print dialog box.

2. Make sure the Scale option is
selected.

3. Enter a Real World scale value of
10’ so the scaleis 1” = 10'.

4. Click “Update.”

The preview window shows 6 boxes,
outlined in red. These represent the pages
across which the diagram will be tiled.

5. Place your mouse pointer on the
diagram in the preview window and
hold down the mouse button.

6. In the figure shown, we used the
mouse to drag the diagram so the
scene is centered in the top four
tiles. You can place the diagram on
any of the pages to optimize how it
prints.

7. Click Print to print the diagram on
the pages shown.
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Printing a Specific View

You can also choose to print a specific view of a diagram, such as a zoomed in view of some details. Use the View
commands to get the view you want on the screen first and then open the Print dialog box.

1. Use the Zoom Window command to
zoom in on the lower-left corner of the

building.

2. Click the Print button to bring up the

Print dialog box.

3. Click the option to print “Current View.
4. Click the Print button to print just that

view.
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In this example we demonstrated
how to construct a simple sketch
of a crash scene, including drawing
an intersection, placing symbols,
drawing skid marks, placing text,
and placing dimensions. Now you
can apply these techniques to
create your own diagrams, making
them as simple or as detailed as
you wish.

Congratulations! You have
just completed your first
diagram with Quick Scene!
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